Chapter 1: Creating
Elements Projects

In This Chapter

1 Understanding creations

1 Creating photo books, greeting cards, and photo calendars
1~ Creating photo collages and slide shows

1 Ordering prints

1~ Making photo stamps and CD/DVD labels

1 Constructing VCDs with menus

1~ Making flipbooks

1~ Sharing creations

A dobe Photoshop Elements offers a number of creations that you can
share onscreen or in print. From both the Create and Share panels in
the Task Pane in the Organizer and from within both editing modes
in the Panel Bin, you have menu choices for producing
creations designed for sharing.

In Chapter 3 of this minibook, we look at sharing files
for screen and web viewing. In this chapter, we talk
about creations designed for print and sharing.

Getting a Handle on Creations

In Chapter 3 of this minibook, we talk about online
albums, attaching files to e-mail, using photo mail,
and using online sharing services. All these creations
offer different output options, such as e-mailing, burning
files to a disc, creating HTML or PDF documents, as well as
printing. You create them all using the Share panel.
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The remaining creations — photo books, photo collages, photo calendars,
greeting cards, print labels, and photo stamps — you create via the Create
panel, shown in Figure 1-1. All these creations are designed for output to
your printer or for sending files to an online printing service or to friends
and family.

When you make a creation that will :
ultimately be sent to an online Organize Fix -(Create’) Share
service or shared with other users,
keep in mind that you first must
select the photos you want in your
creation. For example, before you
create a photo book by clicking the
Photo Book button in the Create
panel, you need to select photos for
your book. If you happen to click the
Photo Book button and nothing
happens, more than likely you
haven’t selected any photos.
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Slide 5

You can select photos in either the
Organizer or the Project Bin in Full
Photo Edit mode.

Instant M

DVD with Menu
After selecting photos, click the
Create button. Elements then opens Il PhotoStamps®
a window respective to the type of
creation you want to make. The wiizliiiie
options for Photo Book, Greeting
Card, Photo Calendar, and Photo
Collage all use the same window
when you click one of the respective
buttons in the Create panel. The [ vCD with Menu...
remaining options, Photo Prints, f&  Flipbook...
Slide Show, and PhotoStamps, use
different windows where options are
selected.

E—j CD Jacket...
D CVD Jacket...
(‘?\ -y T

. CD/DVD Label...

Figure 1-1: The Create panel.

Elements offers you some consistency when creating photo books, greeting
cards, photo calendars, and photo collages. If you know how to set attributes
for one of these creations, you can easily work with any of the other creation

types.
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¢MBER The Instant Movie button in the Create panel requires Adobe Premiere
Elements. If you click this button without having Premiere Elements
installed, a dialog box opens and gives you the choice to download a trial
version of Premiere Elements. We encourage you to use the trial version to
judge for yourself whether the application might work well for the type of
creations you want to make.

After you make a creation, you can save it as a project that can also be
added to the Organizer window. Photoshop Elements projects are saved as
Photo Project Format with a . pse extension. If you want to return to a
project and make more edits, you can open the . pse file and edit your
project. You can add . pse files to the Organizer and view them in the Media
Browser so they'’re easily accessible if you choose to open a project and
perform more edits.

Creating a Photo Book

You can design the creations you make for printing locally to your desktop
printer or for uploading to a professional print service. The professional
services offer you choices for covers, assembly, paper stocks, and so on, as
well as opportunities to distribute the printed material to friends and family.

Photo books follow a sequence of steps that are the same for other creations
you make in Elements. To describe completely the process for making a
creation, we start by showing you how to create a photo book.

Follow these steps to create a photo book:

1. Select files in the Organizer and click the Create tab or open several
photos in Full Photo Edit mode, select the open files in the Project Bin
and click the Create tab.

The procedure for all creations is the same. You first select files in the
Organizer or photos in the Project Bin in Full Photo Edit mode and then
click the Create tab in the Organizer Task Pane or Full Photo Edit Panel
Bin. Ideally, you might start with an album containing the photos you
want to use for your Photo Book. (See Book II, Chapter 3 for more on
creating albums.) You can then just click the album to display the album
photos in the Organizer window and easily select all the photos or select
an Album directly in the Project Bin in Full Photo Edit mode.
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To select all photos shown in an Organizer window, press Ctrl+A (88+A
on the Mac).

2. Click the Photo Book option in the Create panel.

Regardless of whether you're working in the Organizer or an editing
mode, the Photo Book option is available in the same Create panel.
When you click the Photo Book option, a window opens, and you can
make choices for the output and the design of your creation. The same
window opens for other creations such as greeting cards, photo calen-
dars, and photo collages.

3. Choose an option for outputting your creation.

In the left pane shown in Figure 1-2, you make a choice for using
professional online services such as Kodak Gallery or Shutterfly. The
other option you can choose is to Print Locally, meaning you print the
photo book to your desktop printer.

Figure 1-2: Select photos and click the Photo Book option to
open the Photo Book window.

4. Select a theme.

In the middle column, choose a theme for the photo book design. When
you click a theme, the preview pane on the right side of the window
displays a preview of the selected theme. Elements uses an Adobe Flash
interface where you see photo book pages automatically scroll using the
selected theme.
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At this point, click different Craata Share Book IX
themes and observe the Chapter 1
Preview window for a dynamic
display of the respective Q
theme. Take a little time to S
look over all the wonderful -o'?g
options you have for a photo E' m
book design. 73
-]
. Click OK and then examine Z

the pages.

When you click OK, the Create
panel changes and displays
four tabs at the top of the
panel. As shown in Figure 1-3,
the tabs are Pages, Layouts,
Artwork, and Text. On each
tab, you can make additional
edits. On the Pages tab, look
over the total number of pages
for your photo book. If you
want to add more pages, click
the + (plus) icon at the top of
the panel. To delete pages,
click the — (minus) icon.

When you add new pages to a
creation, you’ll want to add
more photos to the pages.
Each new page contains
placeholders for images. To
add more photos, double-
click a placeholder and a
Choose Photo dialog box
opens. Navigate your hard
drive and locate additional
photos you want to include in
your photo book. When you
see a photo in the Choose
Photo dialog box, select the  Figure 1-3: The Create panel has four tabs that are
photo and click the Place used for additional editing.

button.
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6. Click the Layouts tab and
choose a layout.

Craate

On the Layouts tab, you find Pages Layouts
many choices for different
layouts. At the top of the panel, [ISEIMEEIENs
a display of different layouts
appears as shown in Figure 1-4.
Scroll down the panel to find
additional layouts for One, Two,
and Three photos per page.

To change a layout, double-click
the layout choice in the Create
panel. When you change lay-
outs, you need to populate the
placeholders. Drag photos from
the Project Bin to a placeholder,
and Elements fits the photo in
the placeholder frame.

7. Adjust a photo in a frame.

If you change a layout or add
more photos to placeholders, or
even if you let Elements populate
a layout, you may want to make
adjustments for individual
photos within placeholders.

To edit a photo within a
placeholder, double-click the
photo. A toolbar appears
above the photo, as shown in
Figure 1-5. From left to right on ¥ One Photo
the toolbar, you can

e Zoom in or out of the photo

by dragging the slider left
and right.

Done Print

¢ Rotate the photo by clicking
the blue icon. (Each mouse  Figure 1-4: The Layout tab offers many choices
click rotates the photo for changing the layout design.
90 degrees.)

* Get a new photo to place in the frame represented by the folder icon.
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When you finish your edits,
click the green check mark. If
you want to dismiss all edits
and return to the original photo
within the frame, click the circle
icon.

You can also size a photo within
a frame by clicking one of the
handles on the selected image
and dragging in to reduce size
or out to size up. Move the cur-
sor just outside a corner handle
on a selected frame, and you
can rotate the image and frame
together.

If you double-click a photo in a
frame, you can open a context
menu (right-click or Control+click
a one-button mouse on a
Macintosh) and choose from
some transformation options
that include scaling, perspective,
and distorting the photo.
Choose a menu command and
drag a handle to perform the
operation. In Figure 1-6, we
skewed and distorted the
photo.

You can skew an image by
pressing Ctrl/Option and
dragging a corner handle.

. Click the Artwork tab and use

artwork.

Click the Artwork tab, shown in
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Figure 1-5: Double-click an image to open a
toolbar.

Philippine Jeepney

Manila

Figure 1-6: A distorted image as it appears
within a frame.

Figure 1-7. On the Artwork tab, you can change the background design,

frames, and add graphics.

To change the background or frames, double-click a background and/or
frame on the Artwork tab. To add a graphic, click and drag the graphic
to the Image Window where a photo page is displayed.

. Click the Text tab and add some text.

The last tab in the Create panel is the Text tab shown in Figure 1-8.
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Create Share
Text
¥ Settings

== Add Text Block

Font:  Myriad Pro

Style: | Regular

B I U
Size: | 12
Alignment:

Color:

Figure 1-7: Scroll the Artwork tab to find
options for Backgrounds, Frames, and
Graphics.

Figure 1-8: Click the Text tab to add text to
pages.



10.

11.

12.

13.

Creating a Photo Book 577

On this tab, you click the + (plus) icon and
choose options for a font, font style, size,
alignment, and color. You can also warp
text. When a text object is selected, click the
Warp Text button, and the dialog box that
opens allows you to set attributes for warp-
ing the text.

Scroll the panel and you find a number of dif-
ferent styles you can apply to a text object.
Select text after you add it to a page and
double-click one of the style items to apply a
style to the selected text.

(Optional) Switch to Advanced mode to
edit the layers.

Click the Switch to Advanced Mode button

in the Organizer (look ahead to Figure 1-10) to see a breakdown of the
layers and effects Elements applied to your design, as shown in Figure
1-9. You can edit the layers for further customization of your photo
book. To do so, you need to know a lot about working with layers, layer
styles, and layer effects as we explain throughout Book VI.

Figure 1-9: Click Switch to
Advanced Mode to gain access
to layers used in the project.

Click the Switch to Basic Mode button if you’re in Advanced mode and
look over the project.

Now you're ready to take the last steps to finish the project.
Toggle the item denoted as Show Safe Zone, as shown in Figure 1-10.

This item displays a blue guideline on the pages that are marked as the
safe zone when the item is checked. Be certain graphics and text appear
within the safe zone before outputting the photo book.

When your project is complete, decide what you want to do with it:
e Click the Print button to print the file to your desktop printer.

e Click the Order button if you want to place an order with Kodak
EasyShare or Shutterbug.

e (lick the Done button to save the project so that you can later return
to it for further editing.
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Luau Party

May 2008

Party at Felis Besort

Figure 1-10: Click Done to save the project, Print to print to a desktop printer, or Order to
place an online order.

All the steps outlined in this section are the exact same steps you use for
making greeting cards, photo calendars, and photo collages.

Getting in Touch with Greeting Cards

You can create greeting cards, as shown in Figure 1-11, in a snap in
Photoshop Elements by using the Greeting Card panel. Here’s how to do it:

1. Open the Organizer and select a photo or open a photo in Full Photo
Edit mode.

2. Click the Create tab in the Panel Bin.

3. Click the Greeting Card option to open the Greeting Card panel.
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4. Follow the same steps as you do with creating photo books that we Book IX
cover earlier in the section “Creating a Photo Book.” Chapter 1
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Figure 1-11: Use the same steps for greeting cards as you do for
creating photo books.

Making a Photo Calendar

Are you ready to design a personal calendar using your favorite photos?
Elements helps you design an attractive calendar of the kids, the girls’
soccer team, the Bullhead Moose fraternity, or any other type of activity
or event you want to work with. Elements makes it easy to create
professional-looking calendars.

Here’s how you create a calendar that can be professionally printed and
ordered via an online service:

1. Select photos in the Organizer. Alternately you can open images in
Full Photo Edit mode and select the open photos in the Photo Bin.

For calendars, you might want to select 13 photos — 1 photo for the
calendar cover and 1 photo for each month. You can also choose
12 photos and use one of the calendar months for the cover photo.

2. Open the Create panel and click the Photo Calendar option.

3. Choose an output source the same as when choosing a source for
photo books.

4. Follow the same steps as we outline in the section “Creating a Photo
Book.”
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Figure 1-12: Photo calendars are edited the same way you edit photo
books.

Assembling a Photo Collage

To put together a photo collage (see Figure 1-13), you first need to select a
few photos in the Organizer or the Project Bin and then click the Photo
Collage option in the Create panel.

The Photo Collage Wizard opens, and you follow the same steps we covered
in the section “Creating a Photo Book.”

Figure 1-13: Photo collages are a snap to
create in Elements.
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Creating a Slide Show (Windows Only)

We have to make some choices for the amount of coverage we can devote to
each feature in Photoshop Elements. Sometimes it involves some tradeoffs.
Because the process for making creations we’ve discussed so far in this
chapter is vitally important to four creation types, we feel it’s more valuable
to most readers than a thorough coverage of slide shows, especially because
Macintosh users can’t use this feature.

That said, this section includes a brief description for many of the toggles,
switches, and commands available for producing slide shows. Most of what
you find in the Slide Show window is straightforward and intuitive. In addi-
tion, we address many options from the Slide Show Editor (shown a little
later in Figure 1-15) in other chapters throughout this book.

If creating slide shows is important to you and you need more details on
some of the options available, search through the Elements Help system to
fill in the gaps.

Creating slide shows follows the same initial steps as you find with other
creations. To create a slide show using the Create panel, follow these steps:

1. Select the images you want in the Organizer or Project Bin, click the
Create tab, and then click the Slide Show option.

The first thing you see is the Slide Show Preferences dialog box, as
shown in Figure 1-14.

2. You make choices in this dialog box for setting up your slide show —
stuff such as setting transition type, adjusting transition duration, add-
ing music, and adding background color. Click OK when you’re done.

The Slide Show Editor opens, as shown in Figure 1-15.

3. Define the attributes such as transitions, artwork from the Extras
panel, and zooms and time codes.

To add transitions, click the right-pointing arrow adjacent to the transi-
tion icon appearing between a slide and choose from the pop-up menu
the transition effect you want.

Other choices you have for creating slide shows include adding graphics
by dragging items from the Artwork panel and adding text by clicking
the T'tab in the Extras panel and then double-clicking one of the type
styles in the Extras panel.
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Shele Show Brefcrences

Duration

Transition

Curation: 2 sec

< Narration

¥| Show this dialog each time a nev IS created.

Figure 1-14: The Slide Show Preferences dialog box.

. Size, rotate, and perform image editing in the Properties panel.

The Properties panel offers you editing options that we discuss through-
out this book.

. (Optional) Add audio by opening the Add Media menu and choosing

Audio from Elements Organizer or Audio from Folder.

You can have Elements fit the slide duration to the audio duration. Add
the audio and click the Fit Slides to Audio button.

. Choose an output option.

Click the Output button (refer to Figure 1-15), and the Slide Show Output
dialog box opens, as shown in Figure 1-16.

In the dialog box, you have several options from which to choose. These
include

e Save As a File: Click Save As a File, and in the right pane, you can
select from two options:
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Figure 1-15: The Slide Show Editor.

Movie File: Select Movie File to export the file as a video in WMV
(Windows) or QuickTime (Macintosh) format.

PDF File: Select PDF File to export the file as an Adobe PDF
document.

* Burn to Disc: Click Burn to Disc to write a self-running VCD (Video
CD). Note that if you choose to write a VCD, the image resolution is
much lower than writing slide shows to DVDs.

e FEdit with Premiere Elements Editor: This option works only if you have
Adobe Premiere Elements installed on your computer. If you do have
Premiere Elements, clicking this option opens the slide show in
Premiere Elements.

7. Click OK in the dialog box after making the output choice.

Elements outputs your slide show using the settings you applied.
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Figure 1-16: The Slide Show Output dialog box.

Working with Photo Prints

When you open the Create panel and click the Photo Prints option, you find
options for printing files locally on your desktop printer and ordering prints
from online services.

Printing to your desktop printer

When you click Photo Prints in the Create panel, the panel displays options
for printing to your local printer or ordering online prints with a professional
print service. (See Figure 1-17 later in this chapter.)

Click the Print with Local Printer item in the Create panel and the Print
dialog box opens. This action is no different than choosing File=>Print from
the Organizer or when in Full Photo Edit mode. In all cases, the Print dialog
box opens where you set attributes for the print output.

The other options you have for local printing are Print Picture Package and
Print Contact Sheet. These options are also available in the Print dialog box.

For local printing and the options you can use, see Chapter 2 of this mini-
book, where we thoroughly discuss local printing of individual photos, pic-
ture packages, and contact sheets.

Ordering prints online

You can order prints online by using one of a few online print service
providers. Select the photos in the Organizer or Project Bin in Full Photo
Edit mode and then click Photo Prints in the Create panel. The panel dis-
plays all your Photo Print Options for both local and online printing. When
you mouse over one of the online services, a pop-up provides some informa-
tion about the service, as shown in Figure 1-17.
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Working with Photo Prints

Printing to Adobe PDF

All the print options you have in Elements
can be saved as PDF documents. Rather than
collect printed paper documents for items
such as calendars, greeting cards, and photo
collages, you can make your creations and
save to PDF files. You can then share these
files on your social network connections.

To output a creation to PDF, you need a little
help from another application. You have two
choices:

+~ Purchase Adobe Acrobat Standard or Pro
and use the Adobe PDF printer driver that's
installed with your program installation.
Simply choose the Adobe PDF printer in
the upper-right corner of the Print dialog
box and click OK, and your file is then
printed to disk as a PDF file.

+~ Download a free PDF printer driver, such
as pdf995. You can find several PDF print-
er drivers available for free download
by searching the Internet. After a driver is

installed, it appears as a printer. You follow
the same steps as for printing to Adobe
PDF. Select the printer driver in the Print
dialog box and click OK, and the file is then
printed as a PDF.

2

Macintosh users don't need to be concerned
with any printer drivers. Output to PDF is built
into Mac 0OS X. When you choose File=>Print,
click the PDF drop-down list and select Save
As PDF. Your file is saved as a PDF document
that can be viewed in the free Adobe Reader
software.

When you click a print service, a

- [ Create Share

Organize

3

wizard opens and walks you through
the steps for setting up an account
and ordering prints. You also find
options for choosing the address or
addresses where you want your
prints shipped. You can have one
set of prints sent to your address
and duplicate prints sent to family
and friends.

Online print services were once the

Upload your pictures and order
gorgecus prints.
It's easy with Shutterfiy.

I

Drder Prints fram

Figure 1-17: The Photo Prints panel.

cat’s meow for photo distribution. However, in recent years, sharing photos

via social services such as Facebook,

Flickr, MySpace, and Photoshop.com

has proven to be much faster and much more efficient — and more environ-
mentally conscious. Unless you have a good reason for having photo prints,
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join us in using one of the many social service networks we explain in
Chapter 3 of this minibook. The social networks are much more efficient and
less costly than using a print service.

Making Photo Stamps

Another online creation feature in Elements is the option to create your own
postage stamps. Yes, they're real stamps that you can use for mailing though
the post office.

Here’s the simple, easy way to use Elements to place an order for your very
own personal postage stamps:
1. Select an image in the Organizer.

Your file needs to be less than 5MB. (See Book I, Chapter 1 for more on
resizing images.)

2. Click the Create tab in the Panel Bin and then choose the
PhotoStamps option.

The PhotoStamps dialog box opens.

3. Click the Upload My Photos button in the dialog box. (See Figure 1-18.)
Your photo is uploaded to the PhotoStamps.com website.

4. Place your order.

The PhotoStamps.com website provides an easy-to-use interface for
ordering stamps. After you fill out the order and provide billing informa-
tion, your stamps are mailed to you.

= PhatnStamps® _

hotoStamps . .
Real Postage. ME:), You. Adobe Photoshop Services

Turn your favorite photos into your
A very own postage stamps!

It's easy...

L _.} Upload your photo
4 ¢ Customize your design

Place your order

Figure 1-18: Click PhotoStamps in the Create panel to open
this dialog box.
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Getting Organized with CD/DVD Labels

Another creation option in Elements is a simple, easy way to create CD and
DVD labels. From the Create panel, choose a menu item for CD Jacket, DVD
Jacket, or CD/DVD Label from the More Options drop-down list. From tem-
plates provided in the panel, Elements offers you an easy method for print-
ing your personalized labels and jackets for CDs and DVDs.

V?‘“\NG! This feature for printing CD/DVD labels is a bit weak in Elements. You may
S need to fiddle around quite a bit to get the images to fit a label. Using some
templates provided by the label developers is often a much better method

for printing labels.

Creating a UCD with Menu (Windows)

Select a slide show project and open the Create panel. From the More
Options drop-down menu, choose VCD with Menu. The Create a VCD with
Menu dialog box opens, as shown in Figure 1-19. Select a project, make a
choice for NTSC or PAL format, and click the Burn button. The file created is
a Video CD with a menu you can control with your DVD player’s remote con-
trol device.

Figure 1-19: The Create a VCD with Menu dialog box.
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< You need to use an Elements Slide Show Project or a . wmv file. You can’t use

a PDF Slide Show to create a VCD with Menu.

Making a Flipbook (Windows)

At the bottom of the More Options drop-down menu in the Create panel, you
can find a Flipbook command. If you want to create a quick little video that
shows off your photos by flashing stills on your screen or your TV set, you
can quickly create a flipbook. Here’s how you do it:

1. Open the Organizer and select the files you want to use.
Note that you must select at least two files in order to create the flipbook.

2. Click the Create tab in the Panel Bin and choose Flipbook from the
More Options drop-down menu.

The Elements Organizer Flipbook dialog box opens, as shown in
Figure 1-20.

3. Set the playback speed by typing a value in the Speed text box or
moving the slider to the desired speed.

Note that flipping through photos looks best at low speeds, such as one
or two frames per second (fps). Also, you can select the size for your
video file from options on the Movie Size drop-down menu. When shar-
ing files on the Internet, the download speeds increase as file sizes are
increased. To get familiar with the file size that works best for you,
experiment a little by saving files with different output settings.

Figure 1-20: The Elements Organizer Flipbook dialog box permits you
to select a speed and movie file size.
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4. Click the Output button.
The Save Video Flipbook dialog box opens.
5. Type a filename and click Save.

Your file is written as a . wmv file. You can use Microsoft Movie Maker to
write the file to a CD or DVD.

The WMV and QuickTime formats aren’t recognized by many DVD players.
You may need to convert the file format to a format recognized by your DVD
player. Do an Internet search and explore websites that offer freeware or
shareware conversion utilities to find out more about video file formats
acceptable to DVD players.

Sharing Creations

We cover several creations in this chapter, and we emphasize how you can
target the final output format for your creations for your desktop or an
online service printer. Inasmuch as we talk about sharing creations via
online services, we limit our coverage to print output.

For both consumers and professionals, print is giving way to more online
services, which enable you to view photos onscreen on a number of different
display devices, such as desktop, laptop, notebook, and netbook computers;
tablets such as the Apple iPad, or Android-based products; and mobile
devices. You need to understand many issues for preparing files in Elements
and using appropriate export formats to serve the vast number of applications
and services that display and host your pictures.

For a thorough discussion on viewing photo creations onscreen using many
different devices, look over Chapter 3 of this minibook, where we leave the
world of print and talk about sharing your creations for online viewing.
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